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Introduction
QUE$TOR has been designed to produce high level estimates of the 
capital and operating costs of green field oil and gas developments. It 
will assist with project modelling, evaluation and subsequent decision 
making in the oil and gas industry.

QUE$TOR provides a reliable,  consistent  methodology for  producing 
cost  estimates  and  creates  efficiency  when  optimizing  field  
developments. It has benefits in many applications, including:

 l Prospect evaluations
 l Screening studies
 l Feasibility studies
 l Conceptual studies
 l Optimization studies

QUE$TOR uses a systematic approach to generate a field development 
basis, capital  and operating costs, and project schedules from basic 
field data. QUE$TOR uses a bottom up methodology; the calculations 
are based around detailed sizing algorithms and engineering “rules of 
thumb” with regional variations where appropriate.

This approach allows engineers, estimators and economists to produce 
weight and cost estimates quickly, consistently, and accurately and to 
develop investment profiles.

This  guide is  designed to help you understand the operation of  the 
QUE$TOR program, outlining the basic steps involved in developing a 
QUE$TOR  project  to  produce  a  scheduled  estimate  for  capital  and  
operating costs. When you are running QUE$TOR, press the F1 key to 
access the QUE$TOR Help file for more detailed guidance.
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Estimate Basis
The  following  points  should  be  considered  when  generating  or  
reporting a cost estimate using QUE$TOR.

 l QUE$TOR provides  an  estimate  based  on  the  costs  within  the  
markets today. We make no allowance for inflation or deflation of 
costs over the project life 

 l All of the costs within QUE$TOR are in real terms 
 l Pre-sanction project costs such as environmental studies, FEED 

and licensing costs can be optionally included 
 l Post-sanction costs such as owner’s project management costs, 

legal costs and security costs can be optionally included 
 l Contingencies within QUE$TOR are calibrated to target the P50 

development cost
 l QUE$TOR is designed for use early in the project cycle. Therefore 

the estimate level that can be attained by using the program is 
typically within the range of +/- 25% to 40%

 l The  estimate  produced  is  dependent  on  user  entered  values.  
Therefore, any estimate should take into account the confidence 
of these values. 
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About the Quick Start Guide
This guide is  designed to help you understand the operation   of  the 
QUE$TOR program, outlining the basic steps involved in developing a 
QUE$TOR  project  to  produce  a  scheduled  estimate  for  capital  and  
operating   costs. 

QUE$TOR is structured around a field development schematic (FDS) 
which allows you to create a visualization of the development. The FDS 
is driven by a number of high level inputs which allow the development 
conditions  to  be  specified.  The  basic  program calculation  sequence  
followed  in  QUE$TOR to  generate  a  full  life- cycle  field  or  prospect  
development cost estimate is shown below.
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To define the new project,  QUE$TOR presents  you with  a  series  of  
forms  that  allow  high  level  parameters  of  the  development  to  be  
specified. The Field level data form is populated with default   values for 
the basin selected in the Project properties form. Subsequent   forms 
have values and selections based on earlier entries. Once you have   
reviewed and adjusted as necessary the default inputs in each form, 
click   on OK to apply the inputs and move on to the next form. Click   on 
Cancel to ignore changes made and go back to the previous form and 
make any necessary revisions.
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Getting Started
QUE$TOR must be installed on a local PC. This must be done by a local 
administrator. See the release notes for installation   instructions. 

QUE$TOR will run on these following operating systems: 

 l Windows 7 SP1 
 l Windows  8.1 
 l Windows 10 [v1607] 

Note: Windows 8 is no longer a supported OS but Windows 7 SP1 
and Windows 8.1 are.

A license must be available to run QUE$TOR. The license can be either 
a machine specific  standalone license or  a network license which is  
accessible across your company's local area network. License codes are 
emailed to users by IHS Markit Customer Care, called Entitlement Ids, 
the  required  licenses  can  then  be  activated  or  deactivated  via  an  
internet connection. 

QUE$TOR  Offshore,  QUE$TOR  Onshore  and  QUE$TOR  LNG  
Regasification require separate licenses. Contact your IT department 
for further details. 

Depending  on  your  installation  options,  you  can  launch    QUE$TOR  
either from the taskbar Start button or from your PC desktop. 

 

 l Windows 7 SP1 

To  run  the  software  click  the  Start  menu  and    follow  All  
Programs > IHS Markit > QUE$TOR 2022 Q1 > QUE$TOR 
2022 Q1 or double-click the QUE$TOR 2022 Q1 icon created on 
your desktop. 

 l Windows 8.1 

To run the software click the Start menu  and browse the start 
screen to find QUE$TOR 2022 Q1 or double-click the QUE$TOR 
2022 Q1 icon created on your desktop. 
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 l Windows 10 

To run the software click the Start menu and browse the program 
list to find IHS Markit > QUE$TOR 2022 Q1 or double-click the 
QUE$TOR 2022 Q1 icon created on your desktop. 
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Creating a New Project
On opening QUE$TOR the task selection form will appear.

 

On this form you can choose to create a new project, open an existing 
project, and register the QUE$TOR software online via the Sign up 
now  option. The sign up now option also contains the ability to set 
contact preferences and register for future product notification alerts.

For new projects you can either create a new offshore project or a new 
onshore project. There are also shortcuts to the last five projects.

The location of your wells should determine whether you pick offshore 
or  onshore  as  the  starting  point.  If  you  are  running  a  combined  
offshore and onshore project, then you can select the second location 
later in the project estimate.

Once you have selected your project location (i.e. offshore or onshore), 
select  OK  to  open  the  Project  properties  form.  QUE$TOR  then  
confirms that you have a valid license to run the selected project type.
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Selecting the Project Properties
The project properties allow you to setup the basic information about 
your  project  including  the  procurement  strategy,  regional  technical  
database and units set preference.

Work through the following steps to set up your project:
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 l Give your project a name.
 l Select the units you want to work in. Pick from one of the standard 

unit sets provided or create your own using the Unit editor tool. 
For the majority of users one of the default unit sets should meet 
your needs as you can change each unit as needed throughout the 
program.

 l Select the main product. For Oil projects you will have to define 
your recoverable   oil  reserves and a gas oil  ratio,  while for gas 
projects  you  will  input  your  recoverable  gas  reserves  and  a  
condensate gas ratio.

 l Select   the geographical region, country / territory, and basin to 
enable QUE$TOR to seed your project with typical basin specific 
data generated from the IHS Markit IRIS21 E&P database. This 
selection will also drive the default location of a new procurement 
strategy and will set your regional technical database.

 l Create your procurement strategy. This can be done by clicking 
the New button. This will display the Define procurement strategy 
form shown below. Procurement strategies allow you to choose 
different regional cost databases   for each cost centre. By default 
all  costs  are  reported  in  US Dollars    but  this  can  be  edited  by  
changing the currency name, symbol and exchange rate at the top 
of the form.
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 l Select the technical database to use for your project. By default 
this will be the region which you have selected for your project. All 
template databases are shown together with all custom databases 
present  in  the  path  specified.   Click  Browse  to  select  an  
alternative path for custom databases if required.             

Once you have completed the above steps, click OK to move onto the 
Field level data form.
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Entering Your Field Level Data
The Field level data form contains three tabs which list the values for 
the field characteristics, fluid characteristics and some miscellaneous 
data respectively.

The information entered varies slightly depending on whether you have 
selected an offshore or onshore project. Default values are populated   
from a  database  relevant  to  the  basin  you  selected  in  the  Project  
properties form.

On this form, modify the data to the specifics of the field that you   want 
to  produce  an  estimate  for.  The  purpose  of  the  default  data  is  to  
provide a reasonable value where none is known and therefore you 
should   use your values over these defaults. Any input value can be 
changed by simply over-typing it.

In this  form, and any other  form, the individual  input  units  can be 
changed ‘on the fly’ by clicking on the unit to the right of the value and 
selecting the unit you wish to use from the options available, this is 
shown for the recoverable reserves input below.
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Once you have entered / confirmed the data on all three tabs click OK 
to move onto the   Production profile edit form.
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Creating a Production Profile
The production  profile  is  created through two forms;    the  first  form 
gives  seven  entries  through  which  you  can  influence  the  basic  
parameters of your production profile.

Enter any of the values you know at this point and then click OK to 
move  onto  the  Production  profile  form  which  gives  you  a  visual  
representation of these values.

The production profile is displayed in a graphical and   tabular format 
across  four  tabs;  oil  (or  condensate),  gas,  water  and gross liquids.  
Numbers in blue can be edited; numbers in black such as those   in the 
gross liquids tab are derived numbers and therefore can’t be edited. 
This colour convention applies throughout QUE$TOR.
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You can change the production for each year by entering the values in 
the table at the bottom of the form. This can either be typed in year by 
year or you can paste in a profile from an   external spreadsheet through 
a  right  mouse  click.  You  can  overwrite  either  the  daily  or  annual  
flowrates but not the cumulative row of the table. You can also copy the 
data in the production profile and paste it into   an external spreadsheet.

Note: When pasting in a production profile from a spreadsheet 
ensure that the field life specified in the production profile edit form is 
the same as that of the profile you are pasting in.

Once you are happy with the production profile, click OK   to move onto 
the Design flowrates form.
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Setting the Design Flowrates
The Design  flowrates  form gives  the  flowrates  that  will  be  used  to  
design the facilities within your project.

The production values are based on the peak production with a design 
factor for oil projects giving an allowance for day to day variation, and a 
swing factor in gas projects giving an allowance for seasonal demand 
variation. 

The  injection  values  should  be  adjusted  based  on  your  pressure  
maintenance  and  gas  disposal  assumptions.  Water  injection  is  
assumed by default for all oil projects.

Once you are happy with the design flowrates, click OK to move onto 
the Number of wells form.
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Setting the Number of Wells
The Number of wells form, shown below, sets the total number of wells 
required across the field.

The default number of production wells is based on the recoverable 
reserves, well productivity, plateau production and peak   well flow. The 
default  number of  water injection wells  assumes an   average of two 
injectors for every five oil production wells. Gas injectors are based on 
an average flowrate of 30 MMscf/day per well.

Modify the well count to match your design assumptions   and click OK 
to move onto the Wellhead conditions form for onshore projects or the 
Concept selector   form for offshore projects.
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Setting the Wellhead Conditions
The Wellhead conditions form is only available for onshore projects and 
provides the wellhead conditions of the primary streams.

Water injection, gas injection and gas lift pressure are only relevant if 
these services are selected. Adjust the conditions as necessary and 
then click OK to move onto the Concept selector form.
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Selecting a Concept - Offshore
The Concept selector form allows you to choose the basic concept of 
your field development.

QUE$TOR selects a field development   concept based on the field level 
data and production profile. You   can change this to another of the 14 
default  concepts  using  the  list  box.  If  you  want  to  configure  your  
concept from scratch, select 'Blank concept'.

Based on your concept, QUE$TOR will select typical oil and gas export 
options. Adjust these to match your desired product export routes.

When you click OK QUE$TOR runs the complete cost estimate using 
program  defaults  throughout  and  displays  the  field  development  
schematic along with the cost summary tree.

IHS Markit May 2022 Page 21

QUE$TOR 2022 Q1 Quick Start Guide



Selecting a Concept - Onshore
The Concept selector form allows you to choose the basic concept of 
your field development.

QUE$TOR selects a field development concept based on the field level 
data and production profile. You   can change this to another of the 6 
default  concepts  using  the  list  box.  If  you  want  to  configure  your  
concept from scratch,   select 'Blank concept'.

Based on your concept, QUE$TOR will   select typical oil and gas export 
options. Adjust these to match your   desired product export routes.
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When you click OK QUE$TOR runs the complete cost estimate using 
program  defaults  throughout  and  displays  the  field  development  
schematic along with the cost summary tree.
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Using the Field Development Schematic
On selecting your concept and clicking OK QUE$TOR will move through 
to the main field development schematic.

The field development schematic shows the components within your 
chosen  concept  on  the  right  hand  side  of  the  screen,  with  the  
associated  high  level  CAPEX summary  on  the  left  hand side  of  the  
screen.

The schematic can be changed by adding and removing components. 
You can select components to add from the component toolbar at the 
top of the screen and click on the schematic to place the component. To 
delete a component hit delete when the component is selected or right 
click on the component and select Delete. You will be asked to confirm 
any deletions to prevent any components being inadvertently deleted.

Components  often  require  links  so  that  the  correct  data  can  flow  
between them. Components are linked using the link icon in the toolbar

. Once you have linked two components you may need   to add a 
pipeline by double clicking on the link.

Note: Connections from drilling components, subsea, and wellpad 
groups do not require pipelines to be specified.
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Each component will be estimated using default assumptions based on 
the data you have entered so far. To view a component in detail you 
can double click on it or right click on it and select Edit / view cost 
estimate.
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Adjusting a Component
You can view the details of each component by either double clicking on 
the component  icon in  the field  development  schematic  or  by right  
clicking on the icon and selecting Edit / view cost estimate.

Each component has two main parts   to it: the inputs, where you can 
adjust the design parameters, and the cost sheet, where you can see 
the detailed breakdown of the cost.

You can make changes within each of these areas and when you click 
Apply or OK these changes will be applied to the component and the 
CAPEX estimate adjusted accordingly. Clicking on OK   will also exit the 
component. Clicking Cancel   also exits the component; however you 
will lose all changes made since   you entered the component.

Inputs

Page 26 May 2022 IHS Markit

QUE$TOR 2022 Q1 Quick Start Guide



The left hand side of the screen contains the main input data for that 
component.  The  input  form  for  the  topsides  component  is  shown  
below.

The  input  form  shows  the  main  design  parameters  for  a  given  
component, such as the design flowrates. You can make changes to 
these values to match your design assumptions. When you click Apply 
these  changes  will  be  applied  to  the  component  and  the  CAPEX  
estimate adjusted accordingly.

Sub-components

There  are  arrow  buttons   within  many  components  that  can  be  
clicked on to open up one of the sub-components; the details of that 
system are then shown. The topsides Manifolding sub-component form 
is shown below.
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You can make changes within each sub-component and when you click 
OK  these changes will  be applied to the component and the CAPEX 
estimate adjusted accordingly.

Cost sheet

The right hand side of the screen has the cost sheet.  This shows a 
detailed breakdown of the CAPEX estimate for the component. Each 
line item is made up of a quantity and a unit rate. 

 

The quantity is calculated from the design parameters and technical 
algorithms for that item and the unit rate is taken from the selected 
procurement strategy. You can overwrite   any of the blue values within 
the cost  sheet,  as shown for  the quantity entry above.  Numbers in 
black are derived by multiplying the quantity by the unit rate so can’t 
be overwritten.
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Calculating the Operating Costs
The operating cost calculations should be run once you   have finished 
the design of your development as the costs are based on the technical 
definition of the development.

The  OPEX algorithms are  run  by  selecting  OPEX    from the  Project  
menu.  This  will  open  a  separate  window where  a  summary  of  the  
operating costs for each year of production is displayed.

The costs are broken down into various categories, which can be seen 
on the left side of the screen. The detailed breakdown of these cost 
categories can be seen by clicking on these items, they are   formatted 
as blue hypertext. This will open up further definition sheets   for you to 
review or adjust the default values.

Once you are happy with the operating costs, click OK to go back to 
field  development  schematic  so  that  you  can  generate  the  project  
schedule.
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Scheduling the Capital Costs
The  CAPEX  scheduling  calculations  should  be  run  once  you  have  
finished the design of your development as the schedule and costs are 
based on the details of the development.

The  CAPEX  scheduling  module  can  be  accessed  by  selecting    
Scheduling from the Project menu. The schedule will be shown as a 
Gantt chart along with the underlying   data for each component.

For each component, a detailed schedule can be viewed   by expanding 

the component using the  icon. You can adjust the start date and 
activity duration either by dragging the bars within the Gantt chart or 
by adjusting the corresponding values in  the table.  Adjusting these 
values will change when the calculated CAPEX values are to be spent.

Once you are happy with the project schedule, click OK to go back to 
field development schematic so that you can generate the Investment 
and production profile.
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Generating the Investment and Production 
Profile
The investment and production profile is run by selecting   Investment 
and production profiles  from the Project menu.

The investment and production profile gives a report of all of the values 
that  could  be  required  to  run  an  economic  analysis,  with  the  
production, CAPEX and OPEX given for each year of the project. The 
values in this report are in real terms, i.e. they are costs specific to a 
particular point in time (depending on the version) and have not been 
inflated or discounted over the life of the project.

This  report  can  be  printed  or  exported  to  Excel  using  the  toolbar  
buttons.
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Saving Your Project
Projects are not automatically saved in QUE$TOR. We recommend   you 
save your project when you reach the field development schematic and 
at regular intervals after this.

To save a project select Save   or Save As from the File   menu or click 
on the Save project button . This will enable you to save the project 
in the usual Windows fashion. The default location for saved projects is 
Documents\IHS\QUE$TOR\Projects.

Saved project files have a “.qpr” file extension and include the selected 
procurement strategy, technical database and unit set. Once saved, 
projects  are  completely  standalone  and  have  no  further  interaction  
with QUE$TOR’s databases. This means that saved projects can easily 
be sent to others who may not have the same databases.

Saved projects  can be moved,  copied and renamed using Microsoft  
Windows Explorer in the same way as any Windows file. Projects can be 
opened either directly from Windows Explorer or from within QUE$TOR. 
To  open  a  saved  project  in  QUE$TOR either  select  Open   existing 
project from the form that appears when QUE$TOR starts or select 
Open from the File menu.

Note: When you create a new project you won't be able to save 
the project until you reach the field development schematic. 

Opening a Saved Project

To open a saved project select, using   the option buttons, Browse for   
project and click OK to proceed or click on the Open project button 
. This    will  enable  you  to  open  a  project  in  the  usual  windows  
fashion. The   Open existing project box has shortcuts to the last five 
projects  opened  in  QUE$TOR. Saved  projects  have  a  “.qpr”  file  
extension.
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Contacting customer support
Requests for  support  related to the QUE$TOR application should be 
directed to customercare@ihsmarkit.com.

Requests can also be submitted through the IHS Markit website.

Or by phone
Americas: +1 800 447 2273
Europe, Middle East and Africa: +44 (0) 1344 328 300
Asia Pacific: +604 291 3600
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Copyright
Copyright© 2022, S&P Global. All rights reserved.

Windows® is a registered trademark of Microsoft Corporation.   

All  other trademarks and service marks, including without limitation 
QUE$TOR® belong to IHS Markit Inc. and its affiliated and subsidiary 
companies, all rights reserved.

This product, including software, data and documentation1, is licensed 
to the authorized user for its internal business purposes only and no   
part thereof may be disclosed, disseminated, sold,  licensed, copied, 
reproduced, translated, transmitted or transferred to any third party. 
All rights   reserved.

S&P Global Headquarters.
55 Water Street
New York NY
10041

IHS Markit is now a part of S&P Global.

1Build: 2022-05-19:21:14:09
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